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Overview - MySQL to FileMaker

This document shows how to perform a MySQL to FileMaker migration project using FmPro

Migrator. This migration process includes the migration of Tables/Fields and data for all columns
except BLOB columns.

The MySQL to FileMaker conversion process works equally well on macOS or Windows, even
though most of the screenshots in this manual will be shown on macOS.

Revision 2
FmPro Migrator 11.73
1/26/2026

The main update to this revision is the addition of support for the latest versions of MySQL
database versions, including MySQL 9.5+.

FmPro Migrator - MySQL to FileMaker Migration Procedure - 4



Step 1

FmPro Migrator - MySQL to FileMaker Migration Procedure - 5



Step 1 - MySQL to FileMaker - Get Info

Click FileMaker Tab

[ JON ) FmPro Migrator

\elelV| @ FileMaker

.com Solutions Inc.i Chat now

FmPro Migrator will first open to the About tab. Click the FileMaker tab to select the
source/destination database types and enter connection info.
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Select MySQL as Source Database

/Users/dsimpson/Desktop/MySQL_Test/

Get Info

. Drag & Drop B

a example_fmp_dsn19
Admin
FileMaker 19 . example2_fmp_dsn

Admin

.com Solutions'Ine 1 Chat now

Select MySQL from the Source Database menu.
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Enter MySQL Database Connection Info

| NON FmPro Migrator

FileMaker

/Users/dsimpson/Desktop/MySQL_Test/

Get Info

MySQL B

MySQL

FileMaker 19 o ‘ example2_fmp_dsn )

Al O 3

.com Solutions Inc.] Chat now

After MySQL has been selected as the source database, the Step 1 Get Info icon and drop down
menu will change to MySQL

Enter the (1) Hostname, (2) Port, (3) Database Name, (4) Username, (5) Password for the MySQL
database server.

Note: The login security for the MySQL database needs to be configured to allow connections
from the computer running FmPro Migrator.

FmPro Migrator Compatibility with MySQL 8+ - Obsolete Error Message

FmPro Migrator 11.73 and higher versions support the latest versions of MySQL.
Upgrading FmPro Migrator to the latest version solves this problem.
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MySQL Tables List - Shown in Navicat

[ NON Navicat Premium
e & =l B e & S &F B &
$o co Jw & 2  ©o [ ¥y o
Connection New Query Table View Function Others User Query Backup  Automation Mode Charts View
i bl i i h ki i del h i
v mysql5_MBP16 Objects <« T members@test (mysql5_... ‘ | companies@t« ») ®
£ FFLOCATIONS2 B
§ information_schema D@ i E“ % Q s
= : - test
= mysql Name Rows Data Length Engine
£ performance_schema {1 address_book 1 0.07 KB MyISAM ~— Opened
g sys @ asset_management2 5 264.20 KB MyISAM
> § Tasks @ asset_management2_repeating 8 0.20 KB MyISAM
EET & o : ot
> @ companies_2 0 0.00 KB MyISAM
@Tables @ contact_management 1 0.36 KB MyISAM
> (53 views ) contacts 1 77.27 KB MyISAM
> fx Functions ff} contacts_uuid 2 30.03 KB MyISAM
> (2) Events 7 locationtest 8 0.36 KB MyISAM
> @Queries @ maintenance_record 3 10.74 KB MyISAM
> B Backups 7 members 30 3.26 KB MyISAM
- ] members_3 3 0.40 KB MyISAM
= test2 @
notes 1 0.1 KB MyISAM
MySQL8_Docker_MBP15r2 ) tbl_assets 4 103.13 KB MyISAM
mysql_dcsi_dreamhost @ tbl_assets_repeating 8 0.20 KB MyISAM
mysqlLw7vm ) tbl_assets_v1 4 0.21KB MyISAM
onrev_databases @ tbl_maintenance_records 7 0.76 KB MyISAM
@ tbl_value_list_data_items 2 0.04 KB MyISAM
Pg12_MBP15r2
=g 7 tokens 2 0.96 KB MyISAM
$ Fm|uDEV1 Oracle Cloud @ users 2 0.29 KB MyISAM
20 tables

This screenshot shows the list of tables which will be imported into FileMaker Pro by FmPro
Migrator.
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Click Step #1 Get Info Button

FileMaker

FmPro Migrator

/Users/dsimpson/Desktop/MySQL_Test/

—_—
[ —] .
Get Info

MySQL

FileMaker 19 o example2_fmp_dsn
Admin S

.com Solutions Ines i Chat now

Click the Step #1 button, FmPro Migrator will read the table structure info from the MySQL
database.

FmPro Migrator - MySQL to FileMaker Migration Procedure - 10



Importing MetaData

FileMaker

FmPro Migrator

/Users/dsimpson/Desktop/MySQL_Test/

Get Info '

\ MySQL B

FileMaker 19 5 example2_fmp_dsn
Adrmin I

.com Solutions Ines ! Chat now

FmPro Migrator displays an importing dialog, as itis reading the metadata from the MySQL
database. The yellow Continue button will be enabled once processing has been completed.
Click the Continue button to see the imported tables listed in the Migration Process window.
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MySQL Tables in Migration Process Window

| NON Migration Process

TOs

IELEEE  Relationships Value Lists CFs Scripts GUI

“Eam@f

Layouts

Step 2:
Install the FileMaker

ODBC driver. .
companies

¥ iegs 2
Create an ODBC combanies

DSN matching the
DSN name listed in
the Table Details

. ID Original Fieldname PK |Auto-Increment |Next SN New Fieldname

window. 1 middle_name middle_name
2 phonetic_last_name phonetic_last_nam

Turn on ODBC 3 name name
Sharing within 4 organization organization
FileMaker. = e —— denartment
Menu: File > Sharing
> ODBC/JDBC
Click the Get
FieldSize icon.

Troubleshooting:
Make sure the
specified ODBC DSN

Create Table
Not Started

Transfer Data
Not Started

Optional

Image
Transfer

The metadata for the 20 tables from the MySQL database server have been imported into FmPro
Migrator and displayed in the Migration Process window.
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Step 2 - MySQL to FileMaker - Create Tables in FileMaker Pro

Enable Security & Privacy - Accessibility for FmPro Migrator (macOS)

® < e Security & Privacy Q

General  Filevault  Firewall m

ﬁ Calendars Allow the apps below to control your computer.

\/ Reminders
o . AEServer

Q | 4 FmPro Migrator 9.37 DE.app

GoToMeeting v10.17.0
MM Microphone

@ Kitematic (Beta)
Speech Recognition —

_|_ —
® Accessibility @

e ] Input Monitoring

Full Disk Access

OQ

Click the lock to prevent further changes. Advanced... ?

!!!!

On macOS, FmPro Migrator will attempt to automatically open the FileMaker Manage Database
window using AppleScript. FmPro Migrator needs to be enabled under the Accessibility section of
the Security & Privacy section of System Preferences.

(1) Unlock preferences to allow changes, (2) click the Accessibility item then (3) click on FmPro
Migrator so that it has a checkmark next to its name. (4) Click the lock button again to insure that
the changes are updated.

If FmPro Migrator isn't enabled under the Accessibility preferences, you can always open the
Manage Database window manually.
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Click Copy All Tables to Clipboard Button

Migration Process
Value Lists CFs Layouts  Scripts GUI

ﬁzamaf

TOs

IELIESE  Relationships

Step 2:
Install the FileMaker

ODBC driver. .
companies

¥ iegs 2
Create an ODBC combanies

DSN matching the
DSN name listed in
the Table Details

. ID Original Fieldname PK |Auto-Increment |Next SN New Fieldname

window. 1 middle_name middle_name
2 phonetic_last_name phonetic_last_nam

Turn on ODBC 3 name name
Sharing within 4 organization organization
FileMaker. = e —— denartment
Menu: File > Sharing
> ODBC/JDBC
Click the Get
FieldSize icon.

Troubleshooting:
Make sure the
specified ODBC DSN

Create Table
Not Started

Transfer Data
Not Started

FmPro Migrator will copy the FileMaker table creation XML code onto the clipboard, ready for
pasting into FileMaker Pro. The status menu of the Step 2 button will change from Not Started to
Completed.
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FileMakerDB.fmp12 Created & Opened

& FileMakerDB.fmp12
MigrationPreferences.dat
“ MigrationProcess.db3

Since the conversion type is from MySQL into FileMaker Pro, an empty FileMakerDB.fmp12 file will
be created in the output directory and opened automatically.

Accessibility Permissions Dialog - macOS

“FmPro Migrator 9.37 DE.app"” wants
access to control “System Events.app”.
Allowing control will provide access to
documents and data in “System
Events.app”, and to perform actions within

that app.

? Don't Allow

FmPro Migrator will attempt to open the Manage Database dialog within FileMaker Pro. Click the
Ok button in the access control dialog to permit FmPro Migrator to control the FileMaker

application.
You wii need to click the CopyAll Tables button again after clicking the Ok button in this dialog.
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Paste Tables into FileMaker Pro

Manage Database for “FileMakerDB"

Fields  Relationships

A table is a unique set of records and fields. A file can contain more than one table.
1 table defined in this file

View by:  creation order
Table Name Source Details Occurrences in Graph
¢ = Placeholder TO FileMaker 1 field, O records = Placeholder TO
Table Name: |= Placeholder TO I Create Delete
Copy Import...
? Print... Cancel m

Click the Paste button to create the tables within the FileMaker database.
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Tables Created in FileMaker Database

O Manage Database for “FileMakerDB"

A table is a unique set of records and fields. A file can contain more than one table.

Relationships

21 tables defined in this file View by:  creation order
Table Name Source Details Occurrences in Graph
4 asset_management2 FileMaker 42 fields, O records asset_management2
4 contacts FileMaker 42 fields, 0 records contacts
4 contacts_uuid FileMaker 13 fields, O records contacts_uuid
4 members FileMaker 17 fields, O records members
4 contact_management  FileMaker 43 fields, 0 records contact_management
¢ tbl_maintenance_recor... FileMaker 29 fields, 0 records tbl_maintenance_records
¢ members_3 FileMaker 17 fields, O records members_3
¢ companies FileMaker 5 fields, O records companies
4 address_book FileMaker 63 fields, 0 records address_book
¢ locationtest FileMaker 4 fields, 0 records locationtest
4+ tokens FileMaker 5 fields, O records tokens
¢ tbl_assets_v1 FileMaker 5 fields, O records tbl_assets_v1
4 users FileMaker 12 fields, O records users

Table Name: “ Create Delete

Copy Paste Import...
? Print... Cancel ﬁ

The new tables will be displayed in the Manage Database window.
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Step 3
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Install FileMaker ODBC Driver - Windows - FileMaker 11+

Install the FileMaker ODBC driver from within the xDBC folder on the installation CD or CD image

file.

Downloading the FileMaker ODBC Driver

Software Update: FileMaker xDBC client drivers for FileMaker

xDBC Client Drivers for FileMaker 19

Products Windows download Macintosh download
FileMaker Pro 19.4.1 -
" n
FileMaker Server 19.4.1 Requires 64-bit ODBC Manager
Products Windows download Macintosh download
FileMaker Pro 19.3.1 .
" n
FileMaker Server 19.3.1 Requires 64-bit ODBC Manager

The FileMaker ODBC driver is also available from the Claris support website:

https ://www.claris.com/resources/downloads/

On this web page, look for the item labelled:
xDBC update for FileMaker Platform

This item will link to the page shown in this screenshot, the actual URL has a very specific
document number, which might change - so itis best to start with the downloads page.
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32-Bit Versus 64-Bit Installations - FileMaker Pro

,a Fi Ie M a ke r Pr'.;j. 18 _j Vancec i

Version: 18.0.2.209 (07-05-2019)

Windows Platform: Windows 10 Pro
Application Architecture: 64-bit
Physical RAM: 4,073.300 Meg (80% Used)

Windows Version: 10.0 (Build 19043) e

License Key:

0 — Credits | | About oK

Starting with FileMaker Pro 19, only 64-bit versions are available for installation. Earlier versions of
FileMaker mayinclude both 32-bit and 64-bit versions. To find the version of FileMaker running on
your computer:

1) Select the Help -> About FileMaker Pro Advanced menu. 2) Click the Info button as shown

above to see the Application Architecture.

If you are running the 64-bit version of FileMaker Pro, then you want to be using the 64-bit version
of FmPro Migrator and the 64-bit version of the ODBC Administrator to create the ODBC DSN.
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FmPro Migrator - 64bit

.4 FmPro Migrator - O X

com Solutions Ings !

Both 32-bit and 64-bit versions of FmPro Migrator are available. The About screen shows which
version you are running.
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Create ODBC DSN - Windows

9 . Search Administrative 1
Organize v Burn =y 0 @
& Favorites Name . Date modified Type Size l
B Desktop (#)- Component Services 7/13/2009 9:09 PM  Shortcut 2KB
& Downloads © SR TR TR PV 7/13/2009 9:08 PM Shortcut 2KB
%] Recent Places 7/13/20099:08PM  Shortcut 2KB
o~ [ Maintains ODBC data sources and drivers. }"tCUt 2KB I
4 Libraries faf, iSCSI Initiator 7/13/2009 9:08 PM  Shortcut 2KB |
5| Documents (@ Local Security Policy 6/5/2011 9:50 AM Shortcut 2KB
o Music (&) Performance Monitor 7/13/20099:08 PM  Shortcut 2KB
=/ Pictures @ Print Management 6/5/2011 9:49 AM Shortcut 2KB
B videos [ Services 7/13/2009 9:08 PM  Shortcut 2KB
(# System Cenfiguration 7/13/2009 9:08 PM Shortcut 2KB
1% Computer @ Task Scheduler 7/13/2009 9:09 PM Shortcut 2KB
&, Local Disk (C:) &P Windows Firewall with Advanced Security  7/13/2009 9:08 PM  Shortcut 2KB I
5 FileMaker_xDBC_Up: Windows Memory Diagnostic 7/13/2009 9:08 PM Shortcut 2KB I
5 share on 'psf' (X) (2l Windows PowerShell Modules 7/13/2009 9:51 PM  Shortcut 3KB

4 Home on 'psf' (V:)
® Host on 'psf' (Z:)

¢§ Network

', l4items

=]
E

To create a new System ODBC DSN, open the Control Panel > Administrative Tools > Data
Sources (ODBC) Control Panel.
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64-bit ODBC Data Source Administrator

; ODBC Data Source Administrator (64-bit) b 0 X

User DSN System DSN  File DSN Drivers Tracing Connection Pooling About

System Data Sources:

Name Platform  Driver N Add...
m 64-bit Microsoft Access Driver (*.mdb, *.acc

example_acs_dsn32bit 32bit Microsoft Access Driver (*.mdb) Remove
example_acs_dsn64bit 64-bit Microsoft Access Driver (*.mdb, *.acc
example_fmp_dsn18_32bit 32bit FileMaker ODBC Configure...
example_fmp_dsn19 64-bit FileMaker ODBC

OracleCloud_dsn 64-bit Oracle in instantclient_19_6

SQL_Server_2017_dsn 64-bit SQL Server

SQL_Server_2017_dsn_32bit 32-bit SQL Server

salserver2 dsn 32bit SQL Server v

< >

An ODBC System data source stores information about how to connect to the indicated data provider.
0| A System data source is visible to all users of this computer, including NT services.

Cancel Poply Help

The 64-bit ODBC Administrator shown in this screenshotis available from the path:
%windir%\system32\odbcad32.exe

Both 32-bit and 64-bit ODBC DSNs are displayed in the ODBC Administrator, as shown in the
Platform column of the listing.

Running under Windows 10, it shows (64-bit) in its window title when running.
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32-bit ODBC Administrator

| ODBC Data Source Administrator -_— e ld—hj

°Y File DSN I Drivers I Tracing I Connection Pooling I About

System Data Sources:

Name Driver 2
acs_dsn Microsoft Access Driver (".mdb, ~.accdb)

example_fmp_dsn10 DataDirect 32-BIT Sequelink 5.5
example_fmp_dsn11 FileMaker ODBC

An ODBC System data source stores information about how to connect to
the indicated data provider. A System data source is visible to all users
on this machine, including NT services.

Lll [ OK ][ Cancel ] Apply Help

The 32-bit ODBC Administrator is available from the path:
%windir%\syswow64\odbcad32.exe

This screenshotis from an earlier version of Windows, which doesn't show the Platform type in
the list of ODBC DSNs and italso doesn't show in its title whether itis running 32-bit or 64-bit.

(1) Click the System DSN tab, then (2) click the Add button.
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Select ODBC Driver - FileMaker 11 - Windows

Select a driver for which you want to set up a data source.

Name

Driver do Microsoft Paradox (*.db )

RekaaRas-auliasagolt Visual FoxPro
cVakel Ulacics Unver

FileMaker Pro

FileMaker SQL Server Driver

FileMaker Text Driver (*.7)

oA InAAE M

' |

-
>

1

:
1
b=

-

-

(1) Select the FileMaker ODBC driver, then (2) click the Finish button.

ODBC Driver Configuration - FileMaker 11+ - Windows (1)

The FileMaker ODBC assistant helps you configure your ODBC driver

and connections.

You will be prompted for the host address and database name.

To configure your data source, click the Next button.

ODBC for
FileMaker

Click Next button.
Click the About button if you need to find the version number for the driver.
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ODBC Driver Configuration - FileMaker 11+ - Windows (2)

This assistant creates an ODBC data source that you can use to
connect to your database.

What name do you want to use to refer to the data source?

0 Named example_fmp_dsni1

How do you want to describe the data source?

Description: ~ FileMaker 11 DSN|

gy

ODBC for
FileMaker

I S aam aam e Sae o o=

1) Enter a name for the ODBC DSN, (2) click the Next button.

ODBC Driver Configuration - FileMaker 11+ - Windows (3)

Which host do you want to connect to?

Host: localhost

The host is typically referred to by its IP address.

. If the database is on this computer, enter localhost.

@ Connect to host to obtain the names of available
databases.

L

ODBC for
FileMaker

]
|
I
|
|
|
|
|
|

H Cancel ]

-

1) If you are using a local copy of FileMaker Pro or FileMaker Pro Advanced, then use "localhost"
as the host name. Otherwise use the IP address or hostname of the FileMaker Advanced Server.
2) You may optionally click the "Connect to host ..." button to get a list of database files.
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3) Click the Next button.

ODBC Driver Configuration - FileMaker 11+ - Windows (4)

Which database do you want to connect to?

o Database: Default -

If your application requires spedial handling of non-English text, dick |f
Advanced Language.

| |
[ Advanced Language... ]

| Hf || Describe text fields as long varchar |

. - || save long running queries to a log file: |

' FileMaker 5000 !

|

' [ < Back ] [ Next > ] [ Finish ] [ Cancel

1) Enter "Default" as the database name. Or if you have multiple database files open locally or on
the server, then select the database name from the list or enter the name of the database. Using
the Default keyword means that you can avoid changing the setup of the ODBC DSN when using
different database files - but it means that only one file can be open atatime.

2) Click the Advanced Language button.
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ODBC Driver Configuration - FileMaker 11 - Windows (5)

Advanced Language Options X

These options affect the way non-English characters are handled by the
driver.

® [ ] Auto-detect language settings for application

@ Multi-byte text encoding:

®

1) Uncheck the "Auto-detect language settings" button, 2) select System (WinLatin1) for the text
encoding, 3) click the Ok button.

It has been found that for proper character encoding, the following configuration works well:
1) Install matching platform versions (64-bit or 32-bit) of the FileMaker database and FmPro
Migrator on Windows.

2) In the FileMaker ODBC driver, disable the Auto-Detect Language checkboxin the Advanced
Language dialog.

3) Set the Multi-byte Text Encoding menu to UTF-8 in the Advanced Language dialog.

For SQL Server:

4) Enable the Perform Translation for Character Data checkboxon the last panel of the SQL
Server ODBC DSN configuration.
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ODBC Driver Configuration - FileMaker 11+ - Windows (6)

Which database do you want to connect to?
Database: Default

If your application requires spedcial handling of non-English text, dlick
Advanced Language.

[ Advanced Language... ]

[ | Describe text fields as long varchar

["]save long running queries to a log file:

ODBC for
FiIeMaker Long query time | milliseconds): | 5000

[ < Back [ Next > ] [ Finish ][ Cancel

Click the Next button.

ODBC Driver Configuration - FileMaker 11+ - Windows (7)

The ODBC data source has the following configuration:
FileMaker ODBC Driver (32-bit) 11.3.76.0

Data Source Name: example_fmp_dsn11
Description: FileMaker 11 DSN

Host: localhost

Database: Default

Use Long Varchar Type: No

Auto-detect Language Settings: No
Multi-byte text encoding: UTF-8

Log Long Running Queries: No

ODBC for
FileMaker

Click the Test button.
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ODBC Driver Configuration - FileMaker 11+ - Windows (8)

: : — — )
FileMaker Login b -
Data Source Name: example_fmp_dsn11 o | 0K |
UserID:  Admin lﬂ’
Password:
b

[

1) Enter Username, 2) Password (if needed), 3) click the Ok button.

Review the test results, make corrections as necessary until the test passes.

ODBC Error Troubleshooting Steps:

1) Verify that the FileMaker database file is open.

2) Verify that ODBC sharing is enabled for the account entered in the connection test dialog
prompt.

3) Make sure that there aren't two different copies of FileMaker running at the same time. Both
older and current versions of FileMaker use TCP/IP Port# 2399 for ODBC connectivity. If this type
of conflict occurs, close both versions of the FileMaker application, and only open the one copy
you want to serve the database file being migrated.

4) Try rebooting the computer (after clicking Ok to save changes and close this ODBC dialog).
Then testthe DSN again after rebooting.

ODBC Driver Configuration - FileMaker 11+ - Windows (9)

FileMaker DSN Configuration &J

Which database do you want to connect to?

Database: Default -

If your application requires special handling of non-English text, dick
Advanced Language.

| Advanced Language... |

:‘J] Describe text fields as long varchar
Save long running queries to a log file:
ODBC for
FileMaker

< Back ‘ ’ Next > ‘ ' Finish ’ ' Cancel

Click the Finish button.
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Install FileMaker ODBC Driver - macOS (FileMaker 11+)

Download ODBC Manager

Mac OS X: ODBC Manager
« | » | + |3 http:/ /www.odbemanager.net/ ¢ | (Q~ Google

[ i Google Voice - Contacts Comcast TV ...D | Fancast Kagi - .com Solutions Inc. Google Finance Dotcomsoluti...ionsinc.net »

2 ODBC Manager

The free ODBC administrator for Mac OS X
Download ODBC Manager 1.0.5

Replaces ODBC Administrator omitted from
Snow Leopard

1.3 MB | Universal Binary

Requires Mac OS X 10.4 or later

Easy to install - just drag to the Utilities folder

Works great with most drivers Made for Snow Leopard

Freely re-distributable - include it with your
application package

ODBC Manager is freeware. Questions? contact support@odbcmanager.net

Download and install the free ODBC Administrator for macOS from www.odbcmanager.net

You will use the ODBC Administrator to create and manage your ODBC DSNs on macOS.
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Install the FileMaker ODBC Driver

FileMaker Pro 11 Advanced

.y\ 1 of 4 selected, 604.8 MB available e

‘\ N |

\
1
\
\
\
\
\

FileMaker Pro 11 Advanced

[N xDBC

Open the X 4 items, 604.8 MB available
xDBC Folder Name
|| JDBC Client Driver Installer

|| ODBC Client Driver Installer,
__' B FileMaker ODBC.mpkg @

B Readme.pdf

xDBC

(1) Open the xDBC folder on the FileMaker install CD (or installerimage DMG file).
(2) Double-click the FileMaker ODBC.mpkg installer to install the FileMaker ODBC driver. Follow
the insular prompts.
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Add a System DSN

(L NeNG)

ODBC Manager

" Us 0! . System DSN § Drivers  Tracing  Connection Pooling  About ]

Name
example_acs_dsn
example_fmp_dsn
example_fmp_dsn7
FMSR_DSN
frontbase_dsn
mysql_dsn
openbase_dsn
oracle_dsn
pg_pv360_dsn
pv360_oracle_dsn
sqlserver2_dsn
sqlserver_dsn
sybase_dsn
test_acs

SQLite ODBC ...

PostgreSQL o...

my database

Driver
Actual Access @
FileMaker 9 ODBC

FileMaker 9 ODBC

Actual Open Source Databases
FrontBase

Actual Open Source Databases
Actual OpenBase

Actual Oracle

Actual Open Source Databases
Actual Oracle

Actual SQL Server

Actual SQL Server

Actual SQL Server

Actual Access

(1) Click the System DSN tab, then (2) click the Add button.

:
:
:
:
:
:
:
:
:
:
:

"

A

v

Add...
 Remove )

| A TEE—-
[ Configure... )
S
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Choose the FileMaker ODBC Driver

SN$) ODBC Manager
- (x'0ose adriver: v
Driver
Name
exan Actual Oracle i )

exant A'ctual SQL Server

exarm

FMSR

front )
mysq SQLite3
open

oracl

pg_p'
pv36

Cancel

OK

sqlserver2_dsn

sqlserver_dsn

sybase_dsn

test_acs my database

Actual SQL Server
Actual SQL Server
Actual SQL Server
Actual Access

-

(1) Select the FileMaker ODBC driver from the list, (2) click the Ok button.
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FileMaker ODBC DSN Configuration - Page 1

FileMaker DSN Configuration

R

O Introduction
Data Source
Connection
Database

Conclusion

=

>
ODBC for
FileMaker

Click the Continue button.

Introduction

The FileMaker ODBC assistant helps you manage your ODBC driver
and connections.

About...

You will be prompted for the host address and database name.

To configure the data source, click the Continue button.

| ———————C—C——. . -
[ Cancel ) Co Back Continue
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FileMaker DSN Configuration

Enter the data source name and description

o | i . .
ntroduction This assistant creates an ODBC data source that you can use to

© Data Source connect to your database.

© Connection

name do you want to use to refer to the data source?
Database
Name:§ example_fmp_dsn1l
Conclusion

How do you want to describe the data source?

B Description:
>

ODBC for
FileMaker

Cancel ) {  Finish ) (' Go Back

(1) Enter a name for the FileMaker ODBC DSN. The name used here needs to be exactly the
same as the ODBC DSN Name you enter into FmPro Migrator.

(2) Click the Continue button.

Note: You can pick a different name than you see here, just make sure that you enter exactly the
same name into FmPro Migrator.
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FileMaker ODBC DSN Configuration - ODBC DSN Field in FmPro Migrator

/Users/dsimpson/Desktop/Access_To_FM/

example_fmp_dsn11

In this screenshot, the FileMaker 11 database is the destination database, therefore the FileMaker
ODBC DSN name is entered in the Destination Database ODBC DSN field.

If the FileMaker database was the source database, and the data was being copied to a different
database server, then the FileMaker ODBC DSN would be entered into the ODBC DSN field for

the Source Database (not shown in this screenshot).
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FileMaker ODBC DSN Configuration - Page 3

FileMaker DSN Configuration

Enter the connection information

o | i -
ntroduction Which host do you want to connect to?

© Data Source
© Connection
perostsworeally referred to by its IP add

Database

Conclusion

=

>
ODBC for
FileMaker

|| Connect to host to obtain the names of available databases.

Cancel ) {  Finish ) (' Go Back

,

(1) Enter the hostname for the FileMaker database (defaultis localhost).

(2) Click the Continue button.

For a file which has been opened on your local desktop machine, leave the default setting of
localhost.

For a hosted file hosted by FileMaker Server Advanced, enter the IP Address or hostname of the
FileMaker Server Advanced computer.
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FileMaker DSN Configuration

Enter the database information

o | i .
ntroduction Which database do you want to connect to?

© Data Source
) Database:§ Default T]
© Connection o

O Database , . . . .
If your application requires special handling of non-English text,

Conclusion click Advanced Language.
9 . Advanced Language...

| Save long running queries to a log file:

-

l‘J_‘ j 4
ODBC for Long query time (milliseconds): 5000
FileMaker

Cancel ) [ Finish " GoBack ) [ Continue )

(1) For mostlocally hosted database files, enter the text "Default" into the Database field, instead
of selecting a database from the list. This way you can use any single database file without
re-selecting the database name each time you open a new file.

To use this feature, you must only have one FileMaker database file open ata time, or an error will
occur when attempting to read info from the database.

(2) Click the Advanced Language button.
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FileMaker ODBC DSN Configuration - Page 5

FileMaker DSN Configuration

These options affect the way non-English characters are handled by
the driver.

ntrod
O'_, Auto-detect language settings for application

Data
© | Application uses the "wide" ODBC API
Connectj

r ) reat text types ag o
Databasy System (MacRoman)

3h text,

ODBC f(__)r Long query time (milliseconds): 5000
FileMaker

(1) Un-check the Auto-detect language settings checkbox.
(2) Select UTF-8 from the Multi-byte text encoding menu.
(3) Click the Ok button.
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FileMaker DSN Configuration

Enter the database information

o | i .
ntroduction Which database do you want to connect to?

© Data Source

: | -
© Connection Database: | Default j

O Data . . . . .
IR If your application requires special handling of non-English text,

Conclusion click Advanced Language.

 Advanced Language... )

__|Save long running queries to a log file:

Choose...

ODBC for Long query time (milliseconds): 5000
FileMaker

( cCancel ) ( Finish ) (' GoBack :(Continue)

(1) Click the Continue button.
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FileMaker DSN Configuration

O Introduction
© Data Source
© Connection
O Database

© Conclusion

-

l"“u j 3,
ODBC for
FileMaker

(1) Click the Test button.

Conclusion

The ODBC data source has the following configuration:

FileMaker ODBC Driver 11.0.58

Data Source Name: example_fmp_dsnll
Description:
Host: localhost
Database: Default
Auto-detect Language Settings: No
s "Wide" API: No
Treat Text Types as Unicode: No
Multi-Byte Encoding: UTF-8
Log Long Running Queries: No

(' Cancel , (' Go Back

c

N

If the test fails, use the following steps to enable ODBC sharing for the FileMaker database.

Note: Each FileMaker database needs to have ODBC sharing enabled individually.

FileMaker ODBC DSN Configuration - Page 5 - ODBC DSN Test

FileMaker Login

Enter the (1) Username, (2) Password, then (3) click the Ok button to testthe ODBC DSN.

Data Source Name: example_fmp_dsnll

Y r—| O

Co

FmPro Migrator - MySQL to FileMaker Migration Procedure - 43




FileMaker ODBC DSN Configuration - Page 5 - ODBC DSN Test

Test Results:

Attempting to connect to database Default on host localhost

(1) Click the Ok button.
If the test passes, this dialog will be displayed, showing thatthe ODBC Driver Manger has used
this ODBC DSN to successfully connect to the FileMaker database.

If the test fails:

1) Verify that the FileMaker database file is open.

2) Verify that FileMaker ODBC sharing is enabled for the account entered in the connection test
dialog prompt.

4) Make sure that there aren't two different copies of FileMaker running atthe same time. Both
older and current versions of FileMaker use TCP/IP Port# 2399 for ODBC connectivity. If this type
of conflict occurs, close both versions of the FileMaker application, and only open the one copy
you want to serve the database file being migrated.

5) Tryrebooting the computer (after clicking Ok to save changes and close this ODBC dialog).
Then test the DSN again after rebooting.
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FileMaker DSN Configuration

Conclusion

Salntroauction The ODBC data source has the following configuration:

© Data Source
FileMaker ODBC Driver 11.0.58

© Connection
Data Source Name: example_fmp_dsnll

© Database Description:
. Host: localhost
© Conclusion Database: Default

Auto-detect Language Settings: No
Application Uses "Wide" API: No
Treat Text Types as Unicode: No
Multi-Byte Encoding: UTF-8

Log Long Running Queries: No

ODBC for
FileMaker

( cCancel ) ( Test ) [ Go Bac‘ :’

(1) Click the Done button to save the new ODBC DSN.
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Enable ODBC/JDBC Sharing within FileMaker Pro

New Database...

Open... ®¥0
Open Remote... 4 #0
Open Recent >
Close #W
Manage >

FileMaker Network...
Instant Web Publishing...
ODBC/JDBC...

Sharing

File Options...
Change Password...

Page Setup...
Print... #P

Import Records >
Export Records...

Save/Send Records As >
Send Mail...

Send Link...

Save a Copy As...

Recover...

ODBC/JDBC Sharing needs to be enabled within any FileMaker Pro database file which is going
to be used with the FileMaker ODBC driver.
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Select Sharing Parameters

FileMaker ODBC/JDBC Settings

ODBC/JDBC Settings
Turn on ODBC/JDBC Sharing to publish all shared open files using this protocol.

ODBC/JDBC Sharing: :00

File access via ODBC/JDBC

rrently open files
ODBC/JDBC access to file

FileMakerDB.fp7 File: FileMakerDB.fp7

@ ® All Users

__ Specify users by privilege set (_ Specify...  .|
T No users

L C oK)
(_Cancel ) {ESOKSS
.

(1) Turn on ODBC/JDBC Sharing, (2) for the currently open FileMaker Pro database file, (3) for All
Users, then (4) click the Ok button.
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Step 3 - MySQL to FileMaker - Transfer Data

Click Step #3 - Transfer Data Button

Tables

Step 2:
Install the FileMaker
ODBC driver.

Create an ODBC
DSN matching the
DSN name listed in
the Table Details
window.

Turn on ODBC
Sharing within
FileMaker.

Menu: File > Sharing
> ODBC/JDBC

Click the Get
FieldSize icon.

Troubleshooting:
Make sure the
specified ODBC DSN

Migration Process

Relationships  TOs  Value Lists Fs Layouts  Scripts GUI

’“Hlam@l#'

companies
compnanies 2 > ies FileMaker 19

Original Fieldname PK |Auto-Increment |[Next SN New Fieldname
middle_name middle_name
phonetic_last_name phonetic_last_nam
name name

organization organization

denartment denartment
D

U’I-h())l\)—\a

Create Table Transfer Data

Completed Not Started

If you have already opened the new FileMakerDB.fmp12 database file and configured the ODBC
DSN for the FileMaker Pro database, just click on a table in the list of tables then click on the Step
#3 Transfer Data button in the Migration Process window.
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Repeat this process for each imported MySQL table.

ODBC DSN Error - Connecting to FileMaker Pro Database

If you getan ODBC DSN connection error, review the steps for installing the FileMaker ODBC
driver and creating the ODBC DSN for connecting to the FileMaker Pro database. The FileMaker
database mustbe open, and ODBC sharing needs to be enabled. Also, make sure that the name
of the ODBC DSN you entered into FmPro Migrator for the destination database matches the

name ofthe ODBC DSN you created.
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Imported Data in FileMaker

[ NN FileMakerDB
> V. 1 '3I'c(>)tal (Unsorted) O\ v l§ m v Q- >
Records New Record Find Sort Share
Layout: [ members v| ViewAs: E = E [ Preview ) A* [ Modify... |
j first_name last_name  home_addres... home_addres... city country
Andre Common 147 White Los Angeles USA AE
Steve Williams 789 Ninth New York USA AE
Kentaro 7>/ % |Ogawa /J\/I| 2-23-5 Imachi  |Setagaya Tokyo Japan AE
Mary Smith 123 EIm St. New York USA DE
Marie Durand 1ruedela Paris France DE
Sophie Tang 126, Deepwater Kowloon Hong Kong DE
Juanita Alvarez 147 Houston New York USA DE
William Johnson 852 Marsh Road London UK DE
Annelies Verhaag Blauwburgstraat Amsterdam Netherlands DE
Juan Garcia Calle Real Colonia Mexico Df Mexico DE
Sven Svensson Klammerdamms Stockholm Sweden DE
Jacques Dupont Rue des Alpes Lausanne Switzerland DE
A. N. Other The Cottage Mayflower Lane [Bristol UK DE
Bengt Larsen Vogts gate 33 Oslo Norway DE
Michelle Cannon 123 4th St. SW Edmonton Canada XY
John Smith 41 Mary St Sydney Australia XY
Patrick Murphy 89 Lavenworth [Castleknock Dublin Ireland XY
Jean Durand 1001 place du Montreal Canada XY

After transferring the data into the FileMaker database it can be displayed like any other table. This
screenshot shows a sample table containing UTF-8 data for the 3rd record having been imported

and displayed correctly.

When FmPro Migrator connects to a MySQL database server, it sets the character setto UTF8MB4

to insure that all unicode characters are transferred correctly.
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UTF8MB4 MySQL Database Configuration

@ @ Edit Schema

Database Name: test

Character Set: utf8Smb4 a

Collation: utf8mb4_unicode_ci a

Cancel IS

If unicode characters aren't being transferred properly, the character set encoding could be the
cause of the problem. You could test setting up the database character setas shown in this
screenshot of the Navicat Edit Schema dialog. This dialog is accessed via right clicking on the
database name in the list of databases, then selecting Edit Database from the contextual menu

which pops up.
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